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Copyright Information
 Phonos - The Digital SoundShop is furnished under a license or non-disclosure agreement.    
Phonos - The Digital SoundShop may be used or copied only in accordance with the terms of 
the agreement.    Phonos - The Digital SoundShop is not to be used on more than one 
computer by the purchaser.    You are not allowed to decompile, modify, or change the 
software in any way.    It is against the law to copy this software on any medium except as 
specifically allowed in the license or non-disclosure agreement.    The purchaser may make 
one copy of Phonos - The Digital SoundShop for backup purposes.    No part of Phonos - The 
Digital SoundShop, its initial directory, and/or subdirectory may be reproduced or 
transmitted in any form or by any means, electronic or mechanical, including information 
recording and retrieval systems, for any purpose other than the purchaser's personal use, 
without the express written permission of I.Q. Soft.

Copyright (c) 1993,1994    I.Q. Soft, Inc. ,    Jeff Coleman        All Rights Reserved



Technical Support

If you have questions, problems, or comments regarding Phonos - The Digital SoundShop, or 
you are inquiring about future updates of Phonos, please contact I.Q. Soft at the address and
phone numbers
                                    listed below:

I.Q. Soft, Inc.
41800 Enterprise Circle South
Suite H
Temecula, California    92590

phone:    (909) 695-1744
            fax:    (909) 695-1747

Please have the registration number of your copy of Phonos, your computer configuration, 
and brand of sound card available when contacting I.Q. Soft.    





Phonos' Menus
 Phonos' commands are arranged in groups under menus that have one-word names.    These single words appear in 
the horizontal menu bar at the top of the Main Screen.    Each Phonos menu item is related in some way to others in 
the same menu.    Such a collection of "menus" contain the full complement of "commands" with which the Phonos 
user executes operations with audio files.

To know more, point and click anywhere, as appropriate, in the graphic below.    A box of detailed information will 
come to the screen.    Click anywhere in your screen to make it go away.



File Menu Items
The File Menu items are concerned with external (to editing, etc.) functions, such as the organization and storage of
audio files.    You use them to (1) open the WaveFile you want to edit, (2) delete the WaveFiles you want to discard, 
(3) save your Phonos preferences, and (4) terminate your Phonos session.

To know more, point and click anywhere, as appropriate, in the graphic below.    A box of detailed information will 
come to the screen.    Click anywhere in your screen to make it go away.



Edit Menu Items
The Edit Menu contains the two options that allow you to update the current edit of the WaveFile you are working 
on and to revert back to a previous edited version.

To know more, point and click anywhere, as appropriate, in the graphic below.    A box of detailed information will 
come to the screen.    Click anywhere in your screen to make it go away.



Zoom Menu Items
The Zoom Menu items allow you to zoom in on the beginning or end of any currently marked area, so that you may 
make your edits much more precise.

To know more, point and click anywhere, as appropriate, in the graphic below.    A box of detailed information will 
come to the screen.    Click anywhere in your screen to make it go away.



Clips Menu Items
The Clips Menu items make up the core of Phonos' capabilities.    The first four relate to entire ClipFiles, which are 
"folders" containing one or more ClipAreas.    The rest have to do with individual ClipAreas and are central to 
Phonos' editing capabilities.

To know more, point and click anywhere, as appropriate, in the graphic below.    A box of detailed information will 
come to the screen.    Click anywhere in your screen to make it go away.



Mix Menu Items
The    Mix Menu items are concerned with Phonos' mixing and echo capabilities.    These procedures may be undone 
or saved by using the Undo Last WaveFile Edit or the Save New WaveFile commands from the Edit Menu, 
respectively.

To know more, point and click anywhere, as appropriate, in the graphic below.    A box of detailed information will 
come to the screen.    Click anywhere in your screen to make it go away.



Volume Menu Items
The Volume Menu items relate to adjusting the volume level of the currently open WaveFile.

Also, you can point and click anywhere, as appropriate, in the graphic below.    A box of detailed information will 
come to the screen.    Click anywhere in your screen to make it go away.



MIDI Menu Items
The MIDI Menu items allow you to playback (and even delete) MIDI Files with Phonos. To know more, point and 
click anywhere, as appropriate, in the graphic below.    A box of detailed information will come to the screen.    Click 
anywhere in your screen to make it go away.



Creating ClipAreas
The creation and use of ClipAreas is the core of Phonos' editing capabilities.    ClipAreas are small "snippits" from 
WaveFiles and are very easy to create.    Follow the steps below to create a ClipAreas.

1.    Mark the desired beginning of the new ClipArea by pointing and clicking a black line in the Expanded 
View with your left mouse button, and click the Mrk B Clip button to lock that position as the beginning.

2.    Mark the desired end of the ClipArea by pointing and clicking another black line into the Expanded 
View with your left mouse button, and click the Mrk E Clip button to lock that position as the ending.

The area between the two lines that you marked should now be blackened.    This is the region you have selected as 
your new ClipArea.    It is not yet a ClipArea, however.    To make it a ClipArea, simply choose the Name Marked 
Area command from the Clips Menu.

See also:

Saving ClipFiles
Sorting ClipAreas into Directories



Manipulation Window Controls - Main Screen
The Manipulation Window Controls are those buttons that are arranged across the middle of your Main Screen in the
WaveFile Manipulation Controls Window.    Those on the top row are based on the familiar cassette player and    
perform identical or similar functions,    while the controls on the bottom are specific to digital audio editing and 
Phonos.

Use the graphic below to obtain help on each of the Manipulation Window Controls buttons.    Point and click 
anywhere, as appropriate.      A box of detailed information will come to the screen.    Click anywhere in your screen 
to make it go away.



Volume Adjustments
Phonos provides the user with a vast range of volume-adjustment ability.    To increase or decrease the volume of a 
WaveFile select the Increase WaveFile Volume or Decrease WaveFile Volume command from the Volume Menu.    
This will open the "Adjust Volume" dialog box.    At this point, you can use the scroll bar (in one of three simple 
ways) to adjust the volume of the current WaveFile.

Making the Adjustment      Use the scroll bar to increase or decrease the volume of your WaveFile in 
increments of one percent by    (1)    dragging the scroll thumb to the left (for a lesser percentage of increase
or decrease) or to the right (for a greater percentage of increase or decrease), or    (2)    by putting your 
cursor on the left or right arrows at the ends of the scroll bar and clicking the left mouse button.    You can 
also make the scroll thumb jump in 10% increments simply by clicking inside the scroll bar to the left or 
right of the scroll thumb.

The waveform of the currently adjusted WaveFile will show a change, vertically, that is commensurate with
the increase or decrease you ordered when you clicked the OK button in the dialog box.    Now, preview 
your adjustment by clicking the Play button.    If you are satisfied with the change, use the Save New 
WaveFile command from the Edit Menu.    This will replace the pre-adjusted entity with the newly adjusted
one.

Warning      In theory, you can recover a WaveFile at its pre-adjusted volume by simply performing the opposite 
adjustment.    This can be done an unlimited amount of times without any wear on the entity, as it is digital.    
However, if the volume is adjusted downward into the almost inaudible range, the effect---which is permanent if the 
WaveFile is saved after such an adjustment---is that of smoothing out the more subtle contours of the recording and 
its corresponding detail in the waveform.    When the entity so adjusted (and saved) is brought back up to a 
reasonable volume, its quality and continuity will have been degraded by a considerable magnitude.    For this reason
it is advisable to playback your adjusted WaveFile as many times as you need to before saving it (and thereby 
destroying the previous entity).



Inserting ClipAreas
The digital insertion of a ClipArea within a WaveFile is a procedure that is destined to become routine and taken for 
granted, particularly by Phonos users, who can do it more easily than anyone else, anywhere.    In the past, however, 
this was a messy business, requiring three manual splices, one to tie the cut ends of the source tape together and two 
more to insert the clip elsewhere.

An insertion with Phonos involves three simple steps:    (1)    marking the point of insertion,    (2)    selecting the 
ClipArea to be inserted,    (3)    and using the Insert ClipArea command.

1.    Marking    Move your cursor to the precise position of the insertion in the Expanded View; point and 
click a black line into place by using your left mouse button.

 2.    Selecting    Choose the ClipArea you want inserted.    Its name must be present in the ClipFile Window 
(that is, the ClipFile it is part of must be current).    Select it by clicking it once with your left mouse button.

3.    Insertion    Click the Insert ClipArea command from the Clips Menu.    This will complete the 
insertion.



Mixing Two WaveFiles
To mix two WaveFiles (the current one and another from the WaveFile directory), open the current WaveFile with, 
as always, the File Menu's Open WaveFile command.    Select the point you want the mixing to start from by 
pointing and clicking a black line into the Expanded View.    Choose the Mix WaveFile command from the Mix 
Menu to open the WaveFile directory.    Choose the WaveFile that you wish to mix into the current one, and click 
OK.    The mixing now proceeds from the specified position. If the introduced WaveFile exceeds the end of the 
current WaveFile, then the unmixed portion of the introduced WaveFile is left off.

The Mix WaveFile command only results in a temporary mixing on the two WaveFiles.    Preview the result with the 
Play button.    If the composite WaveFile is satisfactory, you can permanently merge its two components with the 
Save New WaveFile command in the Edit Menu.    This command permanently mixes the introduced WaveFile 
(which is a copy of the original in your directory) into your current WaveFile.    For this reason, a warning box 
appears to remind you that the current WaveFile will be permanently altered by the mixing.



Mixing a ClipArea and WaveFile
To mix a ClipArea with the current WaveFile, follow this procedure:    Mark the position where the mix is to start by 
pointing and clicking a black line into place in the Expanded View.    Then, select the ClipArea to be mixed by 
pointing and clicking its name in the ClipFile Window, and choose the Mix ClipArea With WaveFile command from
the Clips Menu.    This executes the mixing from the desired position.    You may preview the newly mixed WaveFile
by pressing the Play button.    If the result is satisfactory, save it by choosing the Edit Menu's Save New WaveFile 
command.    A warning box will appear because the current WaveFile's previous version will be permanently altered 
by being replaced by the mixed entity (although the ClipArea you introduced still exists, in its original form, in the 
ClipFile Window for future mixing/editing operations.).    



Echo WaveFile
To add an echo, or reverberation, to the current WaveFile, simply choose the Echo WaveFile command from the Mix
Menu.    That is all.    Use the Play button to preview the result.

If you wish to save the echo version, simply click the Save New WaveFile command in the Mix Menu.



Echo ClipArea
To add an echo, or reverberation, to the currently selected ClipArea, simply click the Echo ClipArea command from 
the Clips Menu.    That is all.    Listen to the result by double-clicking on the ClipArea's name in the ClipFile 
Window.

Note:      Echoing a ClipArea automatically alters the selected ClipArea.    All operations of    ClipAreas are 
automatically destructive (you will not be able to retrieve the original).



Opening a ClipArea as a WaveFile
ClipAreas can be mixed, inserted, echoed, volume-adjusted, etc., but the WaveFile is, under normal circumstances, 
the audio file type that is actually edited.

On occasion, however, you may want to edit a ClipArea in the same way and for the same reasons that you edit 
WaveFiles.    Because ClipAreas are (in an important sense) small WaveFiles, you may open them onto Phonos' 
Main Screen just as if you were opening a WaveFile.    Instead of opening the ClipArea through the Clips Menu's 
Open ClipFile command, you will open it through the File Menu's Open WaveFile command.    To do this, use the 
following steps:

1. Open the WaveFile Directory with the File Menu's Open WaveFile command to summon the "Open 
WaveFile" window.

2.    Choose the Audio File Type from the small box in the lower left corner of the window, find 
"ClipAreas (*.CPA)" and click twice.    This will cause your list of existing ClipAreas to appear in the upper
left box, irrespective or what ClipFile they belong to.

3.    Select the ClipArea you want to edit and click OK.    Phonos will then write the data to the waveform 
views as it would for a WaveFile.



Sorting ClipAreas Into Directories
 Since a ClipArea must be stored in a file to ever be selected at all, a place must be made for it if a ClipFile is not 
already open (and therefore visible) in the ClipFile Window.    For this purpose,    the "Choose ClipArea Attributes" 
box appears after you have named an unsorted ClipArea.  If there are already ClipArea names in the ClipFile 
Window, the sorting is automatic (and into the open ClipFile).

 At this point, you can choose to put your ClipArea anywhere you want to: in or out of Phonos, but within your 
computer's hard, or internal, drive (drive "c"); or onto a large or small floppy disk (usually drives "a" and "b").    
Under normal circumstances, you will want to put the new ClipArea into a directory created in drive "c",    so find 
(using the scroll bar, if necessary) and click with your mouse, "c".    This will cause the name of the ClipArea to 
appear in the ClipFile Window.    This does not mean that the ClipArea is in a ClipFile, however; but it must be in 
one before you exit the current WaveFile, by which time you will have named a ClipFile to hold the new 
ClipArea(s) on your way out.



Recording Console Controls
Phonos' Recording Console is where you will do your actual recording.    Its elements are a legacy of pre-digital 
recording technology.    To know more, point and click anywhere, as appropriate, in the graphic below.    A box of 
detailed information will come to the screen.    Click anywhere in your screen to make it go away.



MIDI Controls and Indicators
The MIDI Control Panel is an added feature to Phonos.    Although the recording of MIDI songs is not supported by 
Phonos, the MIDI Control Panel has been included so that you may take advantage of playback of MIDI songs 
through the MIDI Mapper found in the Windows (not MIDI) Control Panel.    There are five simple buttons that you 
can use to load, play, and delete MIDI files.

Use the graphic below to obtain help on each of the MIDI Control Panel Controls.    To know more, point and click 
anywhere, as appropriate.    A box of detailed information will come to the screen.    Click anywhere in your screen to
make it go away.



Use of Phonos Scroll Bars
With a scroll bar you can move through the contents of a window or dialog box too small to show all of its contents. 
In every scroll bar that you find in Phonos, you can "scroll" using the arrows at either end of the bar to move the 
scroll thumb, which marks your relative position.    Beyond these similarities, they differ in certain ways.

Main Screen (Expanded View)
ClipFile Window
Volume Adjustment Window - (Volume Menu)
Recorded Waveform Window - (Recording Console)



Use of Mouse Buttons
Your left and right mouse buttons are essential editing tools.    Much of what your mouse can do is applicable to any 
program running under Microsoft Windows.    Others are specific to Phonos.

          Left Mouse Button

1.    Execution of actions within Phonos by clicking menus, commands, controls; these are general 
Windows functions.

2.    Highlighting (with one click) and selection (with two clicks) of files from directories; these are also 
general Windows functions.

3.    Advancement of the starting point of    the playback    in the Compressed View.    Merely move your 
cursor to the desired spot and click the left button once.    Then, when you click Play, the playback will 
begin from that point.

4.    Delineation of ClipAreas in the Expanded View.    Mark the beginning of your ClipArea by moving the
cursor to the desired position and clicking the left button once.    Then "solidify" this with the Mrk B Clip 
button.    Then, mark the end of your ClipArea by moving the cursor to the desired position and clicking the
left button once.    Then solidify this with the Mrk E Clip.

5.    Manipulation of Scroll Bars, of which there are several in Phonos: the Expanded View, the ClipFile 
Window (when it contains more than four ClipArea names),    the Increase and Decrease Volume dialog 
boxes, and the Recorded Waveform Window in the Recording Console.    For the specifics, see Scroll Bar 
Controls.

6.    The playback of ClipAreas.    Simply select the ClipArea in the ClipFile Window that you wish to play 
by pointing and rapidly clicking it twice with your left mouse button.    Playback will continue until the 
entire ClipArea has been played.

7.    Changing the beginning and ending positions of a marked area in the Expanded View and/or either of 
the Zoom Windows.    If a marked area is visible in the Expanded View, you may "point and click" to the 
beginning and/or ending position and, while holding the left mouse button down, you may move the cursor 
to the newly desired sample position.    By releasing the mouse button, the marked area is redrawn to 
display the new change.    This process is the same for beginning and/or ending positions in the Zoom 
Windows.

          Right Mouse Button

1.    The toggling between Play and Stop while your cursor resides within the Compressed View.    Your 
mouse must be pointing within the bounds of the Compressed View Window for this to work correctly.
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Creating ClipFiles
ClipFiles can be viewed as file "folders", which contain 1 or more ClipAreas.    ClipFiles allow you to store related 
ClipAreas together into convenient packages.    Use the following steps to create a ClipFile:

1.    First, in order to create a ClipFile, you must have already created one or more ClipAreas (see Creating 
ClipAreas) and they must be visible in the ClipFile Window.    Note that when you choose to create a 
ClipFile containing ClipAreas, you are referring to those ClipArea names that are currently visible in the 
ClipFile Window.

2.    Next, choose the Save ClipFile command from the Clips Menu.    The ClipArea name(s) contained in 
the ClipFile Window are now saved in the named ClipFile.



SmartDrive and Phonos
SMARTDRIVE is a disk-caching program that is often used with computers that have expanded memory.    It speeds
the disk access time on most applications, however, it also requires a chunk of memory for itself in order to load and
run.    It is highly recommended that if you have 3 MB or less of usable memory at "Phonos run time" (when you are
executing Phonos from Windows), you shut off the SMARTDRV option that is set through AUTOEXEC.BAT.    This
will conserve the maximum amount of memory for loading and manipulating WaveFiles.    To do this, use any editor,
such as NOTEPAD.EXE in Windows or 'EDIT' from the command prompt in DOS.    Locate the line that shows 
"SMARTDRV.EXE..." (or similar) and place a "REM" in front of it.    This changes that line to a remark and it will 
not be read on execution.    After doing this, make sure that you exit Windows and reboot your system because 
AUTOEXEC.BAT is initially read when your computer boots up.    To find the amount of usable memory at any time
while you are running Phonos, enter Phonos' On-Line Help File (as you are in now), press F1, and choose the About
Help menu item from the Help Menu.    The free memory is displayed at the bottom in KBs.    Convert this number 
to MBs by dividing by 1024.    This is the amount of MBs you have free to work with.    This number represents the 
size of the swap file that Windows uses on your hard drive for data manipulation.    For more information on 
Windows' swap files, see your Windows' documentation.



Phonos Memory Limitations
Because the program must load the current WaveFile into memory before you can play or edit it, Phonos is 
dependent on not only the amount of hard drive space (permanent memory) you have, but also the amount of RAM 
(temporary memory) you have.    The more RAM, the better and faster performance you will get from Phonos.    It is 
strongly recommended that you have at least 4 MB of RAM.    This is becoming a standard industry minimum.    
Upgrading system RAM is becoming less costly and is easy to do.    Phonos will run best on 6 MB of RAM or more. 
These memory limitations can affect the Purple Line Tracking Indicator and "File Operation In Progress" wait times.



Purple Tracking Inaccuracy (Compressed View)
The tracking of this purple bar, as it moves across the waveform in the Compressed View, is directly based on 
internal Windows' timers that are called every 1/10 of a second.    Windows' timers, without getting too technical, are
sent as messages.    There can be delays in the sending, based on other activities that are going on in Windows at the 
same time.    If there are several applications open (but minimized to icons) or you are rapidly moving your mouse 
during playback, you will notice that the purple bar may hesitate or fall short of the end of the WaveFile when 
playback stops.    As a general rule, try to close all applications before using Phonos and try not to move your mouse 
too much during playback or recording.



"File Operation In Progress" Wait Times
When Phonos is loading, writing, or manipulating a WaveFile over 2 MB in size, the " File Operation In Progress" 
box appears.    The time you must wait is proportional to the length of the WaveFile being written (and the amount of
RAM you have).    In Phonos, there are three ways to lessen the delay :

  1. Check the SMARTDRIVE setting in your AUTOEXEC.BAT file.

 2. Increase your system memory (RAM) - consult your local computer store for details.

 3.    Record shorter WaveFiles.

Future versions of Phonos will support smaller disk access times, thereby greatly reducing delays. 



DOS Primer
This section explains those few rudiments of the Disk Operating System (DOS) that are specific to using Phonos.    It is included 
for those users who have no knowledge of DOS, but want to get started with Phonos right away, without being told "please 
consult your DOS Manual."

DOS and Windows manage the storage of your files--including, of course, your audio files.    This includes all 
drives:floppy (a,b), internal (c, etc.), and network, plus the directories they contain.    To create these directories on 
particular drives, you use File Manager, which can be found in your "Main Program Group" in Windows.    We 
strongly encourage you to create individual directories for WaveFiles and ClipAreas/ClipFiles, respectively, so that 
these files do not wind up scattered throughout your hard (c) drive.    Another advantage to this is that you can sort 
your WaveFiles and ClipAreas/ClipFiles into small and, therefore, more manageable, packages, so that you may use 
them effectively for editing.    The DOS file structure can be viewed as a staircase structure.    This file structure is 
explained below.

      
This is found in File Manager (at the top of the screen).
This shows you the available drives on your system.    By pointing 
and clicking on each drive, its contents are displayed below it.
Initially, the main directories that reside in the drive that you
chose are displayed as shown in the graphic below.

Notice in this example the only main
directory on drive E is the WINDOWS
directory.    This represents a "file folder"
or package that neatly contains its
own subdirectories and files.



After pointing to and selecting the WINDOWS 
main directory by clicking on it with your mouse,
the right portion of your screen displays the
subdirectories and files that are contained within it.
The yellow folders that are shown at the top of the 
contents represent directories that have their own 
contents, or rightly-named subdirectories.    The 
names next to the clear white folders represent actual
files.    At this point of the directory structure on drive
E, we are at the equivalent point of E:\WINDOWS.      

Point and click one of the subdirectories
(SYSTEM chosen in this case) on the
right side of the screen.    You now are
able to see the open (SYSTEM) folder
subdirectory under the initial WINDOWS
directory on the left of your screen.    At
this point of the directory structure,
we are pointing to
E:\WINDOWS\SYSTEM.    



Now, the subdirectory's (SYSTEM) contents are
displayed, just as before with the WINDOWS directory.

As you can see, the DOS filing structure is similar to a staircase.    As you move up (or down) each level (levels can 
be compared to directories), you find a new set of files and subdirectories.    When you come to understand the 
structure, it actually becomes quite simple.    With this understanding, first create directories that you will store 
WaveFiles and ClipAreas/ClipFiles in by using File Manager.    Then, when creating WaveFiles or creating 
ClipAreas/ClipFiles, you can place them into the special directories that you have created.



File Menu
The File Menu is used to make the external decisions about what to do with WaveFiles that are already in existence.
This group of commands has nothing to do with the development---editing, mixing, or adjusting---of WaveFiles.    
Its use is similar to the use of the "File" menu bar item in most other Windows applications.



Edit Menu
The Edit Menu is used to update an existing edit of a WaveFile or to discard the last change you have made.    It's 
use is similar to that of any word processing program's Edit Menu item.



Zoom Menu
The Zoom Menu contains the two commands that allow you to "zoom in" on the beginning and/or ending positions 
of a currently marked area.    This allows you to make your edits extremely precise by removing "pops" or glitches 
which would be nearly impossible to remove by using the Expanded View alone.



Clips Menu
The Clips Menu contains the commands that relate to that mutable, movable wonder found only in Phonos, the 
ClipArea.    ClipAreas and the bins    they are stored in--ClipFiles--enable you to not only edit and work on whole 
WaveFiles, but parts of WaveFiles.    Furthermore, there is no limit to how many times you can use a    ClipArea, nor
to how many WaveFiles you include it in.    With the Clips Menu, you    name, save, open, close, transfer, mix, 
change the volume, echo, and discard ClipAreas.



Mix Menu
The Mix Menu contains the commands you will use to perform audio mixing with WaveFiles.    Mixing, in general, 
refers to the blending of the current WaveFile with a copy of another WaveFile (or a ClipArea).    The echo is a 
special type of mixing, in that it mixes an audio file not with a copy of another, but with a copy of itself.    In order to
mix a ClipArea with the currently open WaveFile, you would use the Mix ClipArea With WaveFile command found 
in the Clips Menu.

Mixing is not inserting an audio file between the two cut ends of another audio file.    That would be a splice, which 
is an editing, not a mixing task.    But it, too, is possible in Phonos.



Volume Menu
The Volume Menu contains your volume adjustment options for the currently open WaveFile.    These volume 
adjustments are non-destructive to the WaveFile, meaning that you may undo changes by using the Undo Last 
WaveFile Edit command from the Edit Menu.    If you wish to change the volume of a ClipArea, you would use the 
Increase ClipArea Volume or Decrease ClipArea Volume commands in the Clips Menu.



Midi Menu
Phonos' MIDI feature is a stand-alone bonus to Phonos' editing capabilities, although it is not itself an editing tool.    
Despite its intimidating name, the MIDI feature is the easiest part of Phonos to use.    The MIDI Menu is basically a 
miniature file menu in that it contains the keys to playing MIDI files or deleting them.



Open WaveFile
The Open WaveFile command opens the directory of already-existing WaveFiles, which have a .WAV filename 
extension.    Choose--by typing or by clicking the full name (including the extension)--the WaveFile you want and 
click OK.      This causes the WaveFile's visual expression, its waveform, to be written to the Compressed and 
Expanded Views Windows, and its vital statistics to be entered into the Attributes Window.    If you open a WaveFile 
when another is already current (open and visible), then the one you open replaces the other, which is closed (sent 
back into storage in the directory).



Close Current WaveFile
The Close Current WaveFile command closes the WaveFile that is said to be "current" (open and visible on the 
screen), plus the currently displayed ClipArea(s), if any, in the ClipFile Window.    These are sent back to their 
respective directories, and the Main Screen is blanked.    Now you have a clean slate, as if you had just started 
Phonos.

The Open WaveFile command also does all of the above to a current WaveFile, when you use it to open another 
WaveFile without closing the current one.



Delete WaveFile
The Delete WaveFile command summons the WaveFile directory and prompts you to choose--by typing or clicking--
the particular WaveFile you wish to delete from any of the directories/drives on your system.    This command 
should be used with caution because once a WaveFile is deleted, you will not be able to retrieve it.    Its benefit 
comes in clearing unwanted WaveFiles from your hard disk, thereby conserving space and making the remaining 
WaveFiles easier to find.



Save Preferences
The Save Preferences command is used to choose the recording options that you prefer as defaults (automatic 
settings).

You may configure the sampling rate and number of channels in the Recording Console with Save Preferences.    
Every time you start Phonos, the options you chose and saved will be preset in the Recording Console to the options 
indicated.    To change the configuration, simply reselect the options and choose Save Preferences again.    If you    
never use this command, then Phonos will automatically start with a setting of 11 kHz/mono in the Recording 
Console.



Exit
The Exit command is self-explanatory.    Aside from the external Close command in the Windows command box in 
the far upper left corner of the Phonos screen, Exit is the only way to terminate a Phonos session.    It returns you to 
the Windows Program Manager to work in other applications.    You may only use the Exit command when Phonos' 
Main Screen is visible.    While in the Recording Console, the MIDI Control Panel, or within one (or both) of the 
Zoom Windows, you must use a Close, OK, or Cancel button to return you to the Main Screen in order to use the 
Exit command.



Open ClipFile
The Open ClipFile command opens a directory of pre-saved ClipFiles, each of which has a filename extension 
of .CPF.    A ClipFile is a named group of one or more ClipAreas (filename extension .CPA).    For instance, one 
named STOOGES.CPF may contain LARRY.CPA, MOE.CPA, and CURLY.CPA.    These can be opened separately 
as WaveFiles, but the usual route is to open them as a group (a ClipFile) with Open ClipFile.    When the "Open 
ClipFile" Window opens, you are prompted to choose--by typing in or clicking--the desired ClipFile from a list of 
directories/drives.    After making your choice and clicking OK, the ClipFile's inventory of ClipAreas appears in the 
ClipFile Window and its caption bar will display the ClipFile's name.    If you choose this command when a ClipFile 
is already open (visible in the Waveform Views), Phonos will simply close the open ClipFile and open the newly 
selected one.



Close ClipFile
The Close ClipFile command is very similar to the Close Current WaveFile command.    Use it to close (send back to
the directory) an open ClipFile and to blank the ClipFile Window.    This makes room for another ClipFile from 
which to select ClipAreas to use with the current WaveFile.



Save ClipFile
The Save ClipFile command tells Phonos to save, or, more precisely, to update the contents of the open ClipFile.    If
you have added ClipAreas since opening it, you must resave it before you close it, which happens if you select one 
of several commands that will directly or indirectly close the ClipFile: Close ClipFile, Close Current WaveFile, 
Open WaveFile, or Exit.    If no ClipFile is open and you have at least one new ClipArea in the ClipFile Window, that
you want to save into a ClipFile, clicking Save ClipFile summons a dialog box that prompts you to name the 
ClipFile that will hold the new ClipArea(s).    Its path (drive and directory) was already determined when you 
created (named) the first ClipArea (see Name Marked Area for details on how to do this).    You do not have to add 
the .CPF filename extension; Phonos does it for you.    Just type in a name and click OK.    The ClipFile will be 
saved and the caption bar of the ClipFile Window will display its name.



Delete ClipFile
The Delete ClipFile command is very similar to the Delete WaveFile command.    It summons the    "Delete ClipFile"
Window, where you specify the ClipFile to be deleted from whatever drive/directory it is in.    After choosing the 
ClipFile name and clicking OK, the selected ClipFile is deleted along with all that it contained.    Use this command 
with caution; deletions are permanent!    This command allows you to clear your hard drive of    unneeded ClipFiles, 
freeing up hard drive space.



Name Marked Area
The Name Marked Area command is the tool you use to convert a marked area into a proper ClipArea.    The marked
area is a blackened region of a WaveFile made with the Mrk B Clip and Mrk E Clip buttons.    The command opens 
the "Name Marked Area" dialog box.    Type in a name of up to eight letters, without an extension.      (Phonos 
automatically adds the .CPA extension).

 If the ClipArea you are creating is added to an empty ClipFile Window, you must choose the directory/drive that the
ClipArea is to be stored in.    The "Choose ClipArea Attributes" dialog box appears, with its list of available drives 
and directories in which you can place the new ClipArea.    The path shown directly under the text "Current Path" is 
where you are telling Phonos to place the ClipArea.    This changes as you choose different paths by pointing and 
clicking on various drives/directories in the listbox.    Once you are satisfied with the path shown below the text 
"Current Path", click OK and the ClipArea's name will appear in the ClipFile Window.    The filename 
extension, .CPA, is not shown.    All subsequent ClipAreas that you create will be saved to the same path as the first. 
This is so that when you save them all in a ClipFile, they will all be in one convenient package, together in the same 
drive/directory.    The ClipFile, when named, will also reside in the same drive/directory.



Clear Marked Area
The Clear Marked Area command erases or "clears" a black mark from the Waveform Views that you decide not to 
make into a ClipArea, for whatever reason.    The command should not be confused with the Delete Marked Area 
command, however.

Clear Marked Area simply removes the "mark" from the "area."    (The Delete Marked Area command removes 
both.) The waveform remains unaffected by the Clear command.    Suppose you have marked one area, but decide 
you want to mark another    instead.    Choose Clear Marked Area.    Another method of erasure includes using the 
Trans Cursor button in the Manipulation Controls Window.



Delete Marked Area
The Delete Marked Area command cuts a segment out of the current WaveFile that is delineated by the black 
(marked) area.    It could be compared to taking a piece of audio cassette tape, cutting a section out, and splicing the 
ends back together.    This is unlike the Clear Marked Area command which removes only the mark, not the area 
under the mark.



Insert ClipArea
The Insert ClipArea command painlessly splices a ClipArea into the current WaveFile at a black line that you placed
in the Expanded View to mark the desired position of insertion.    It    is a very different procedure from the messy, 
inexact cutting and splicing that were necessary with reel tapes.    In some sense this command is the opposite of the 
Delete Marked Area command, which extracts rather than inserts.

To perform an insertion, you must first tell Phonos which ClipArea you want to insert by highlighting it in the 
ClipFile Window.    Then tell Phonos where to insert it into the current WaveFile    (by marking with the black-line 
cursor, as explained above) and execute the insertion with the command.    The current WaveFile will expand in size 
with the addition of the ClipArea; this expansion will be registered in the Space Occupied On Drive line in the 
WaveFile Attributes Window and in the total time in the yellow time indicator bar in the Compressed View.



Delete ClipArea
The Delete ClipArea command is easily confused with the Delete Marked Area command.    The former    removes a 
ClipArea in the ClipFile Window, and the latter removes a marked, unnamed segment from the current WaveFile.

To delete a ClipArea, point to and click its name (only once) in the ClipFile Window.    Then, execute the deletion 
with Delete ClipArea.



Mix WaveFile
The Mix WaveFile command allows you to mix the contents of a pre-recorded WaveFile with the current one.    First,
click a black line at the mixing point (in the Expanded View) from which the mixing will proceed.    Then use the 
Mix WaveFile command to execute the mixing.    The command opens the "Mix WaveFile" Window in which you 
select from any directory/drive on your system the WaveFile you will mix with the current one.    When you have 
clicked the one you want, press OK.    If the length of the introduced WaveFile exceeds the end of the current one, 
mixing stops at the end of the open WaveFile.

This action creates a temporarily mixed WaveFile, which you can continue to edit, while leaving the original intact.   
This WaveFile action is thus non-destructive.    To make the mixing permanent, you must save it with the Save New 
WaveFile command, found in the Edit Menu.



Mix ClipArea With WaveFile
With the Mix ClipArea With WaveFile command, you can mix a copy of any ClipArea in the open ClipFile with the 
contents of the current WaveFile. The first step, naturally, is to select the desired ClipArea by highlighting it.

 Now, click a black line at the point (in the Expanded View)    from which the mixing will proceed.    Then use the 
Mix ClipArea With WaveFile command to execute the mixing from the specified point.

This action creates a temporarily mixed WaveFile, which you can continue to edit, while leaving the original intact 
underneath it.    This WaveFile action is thus non-destructive.    To make the mixing permanent, you must save it with
the Save Mixed WaveFile command in the Edit Menu.



Echo Current WaveFile
The Echo Current WaveFile command takes the current WaveFile and mixes it with itself, though very slightly 
advanced, to create the echo effect.    This is called automatic echo and is one of two ways to echo a WaveFile.

The other method of echoing, which is called manual echo makes use of the Mix WaveFile command to control the 
advance of the echo (have the echo begin at some point other than the one Phonos automatically begins it at with the
Echo WaveFile command).    Select the starting point, as you would with a regular mixing operation, and choose the 
Mix WaveFile command.    When the directory comes up, select the same WaveFile that is already current.    Clicking
OK executes the manual echo (which is in fact a form of custom-point mixing).

 This action creates a temporarily mixed WaveFile, which you can continue to edit, while leaving the original intact 
underneath it.    To make the mixing permanent, you must save it with the Save New WaveFile command, found in 
the Edit Menu.



Echo ClipArea
The Echo ClipArea command adds an echo to a selected (highlighted in the ClipFile Window) ClipArea.    Use it 
carefully because echoing a ClipArea is destructive, meaning that once you echo the ClipArea, you have lost the 
original, un-echoed version. (Because ClipAreas are generally small, it is possible--and even recommended if their 
total length is considerable--to back them up into another directory or onto a floppy disk before choosing this option,
in case you want to retrieve the original.)

Begin by selecting the ClipArea you want to echo by pointing to its name in the ClipFile Window and clicking    its 
name (in the open ClipFile) once.    Choosing the Echo ClipArea command at this point executes the echo.    Next, 
listen to the echoed ClipArea by double-clicking its name in the ClipFile Window.



Increase WaveFile Volume
The Increase WaveFile Volume command opens a dialog box in which you use a scroll bar to raise the volume of the
current WaveFile by any desired percentage.    The entire WaveFile is affected.    This command does not increase the
volume setting on your sound card, only the volume of the file you are working with.

There is an important difference in using this command to adjust the volume of a WaveFile as opposed to a 
ClipArea.    Any adjustment to a WaveFile is temporary and can be previewed before being made permanent with the
Save New WaveFile command in the Edit Menu.



Decrease WaveFile Volume
The Decrease WaveFile Volume command opens a dialog box in which you use a scroll bar to lower the volume of 
the current WaveFile by any desired percentage.    The entire WaveFile is affected.    This command does not 
decrease the volume setting on your sound card, only the volume of the file you are working with.

There is an important difference in using this command to adjust the volume of a WaveFile as opposed to a 
ClipArea.    Any adjustment to a WaveFile is temporary and can be previewed before being made permanent with the
Save New WaveFile command in the Edit Menu.



Increase ClipArea Volume
The Increase ClipArea Volume command presents you with an "Increase Volume" box.    By using the contained 
scroll bar, you may choose a certain percentage that you wish to increase the volume by.    The ClipArea you are 
manipulating is the currently selected one in the ClipFile Window.    Use caution when implementing this command; 
volume changes to ClipAreas are destructive, meaning that they are automatically overwritten.



Decrease ClipArea Volume
The Decrease ClipArea Volume command presents you with an "Decrease Volume" box.    By using the contained 
scroll bar, you may choose a certain percentage that you wish to decrease the volume by.    The ClipArea you are 
manipulating is the currently selected one in the ClipFile Window.    Use caution when implementing this command; 
volume changes to ClipAreas are destructive, meaning that they are automatically overwritten.



Undo Mrk B Clip
The Undo Mrk B Clip command gives you the flexibility of "starting over" a marked area that you had begun.    If 
you have marked a beginning position in the Expanded View using the Mrk B Clip button found in the Manipulation
Controls Window, and you decide that you want to change the beginning position, you may do so by selecting this 
command.



MIDI Control Panel
The MIDI Control Panel command takes you from Phonos' Main Screen to the MIDI Control Panel Screen, where 
you can playback    MIDI files through a friendly interface.



Delete MIDI File
The Delete MIDI File command opens a directory in which you can specify a deletion of an existing MIDI File from
your hard disk if you do not want it taking up space.    If you click OK, a warning box reminds you that the deletion 
is irreversible.



Zoom Marked Left
This command displays a "zoomed in" view of the Mrk B Clip position that you chose when you created a marked 
area.    You are able to see the current position in detail, so that you may make a precise edit in that small area.    You 
may only use this option when the beginning mark position is visible in the Expanded View.    If it is not visible, 
simply use the Expanded View's scroll bar to move the position into view.



Zoom Marked Right
This command displays a "zoomed in" view of the Mrk E Clip position that you chose when you created a marked 
area.    You are able to see the current position in detail, so that you may make a precise edit in that small area.    You 
may only use this option when the ending mark position is visible in the Expanded View.    If it is not visible, simply 
use the Expanded View's scroll bar to move the position into view.



Undo Last WaveFile Edit
This option allows you to revert back to the previous edit, if any, that you had before you performed a mix, an 
insertion, a deletion of a marked area, a volume change of the current WaveFile, or an echo of the current WaveFile. 
For example, you open a WaveFile and perform a volume change to it.    You may undo the volume change, which 
will revert you back to the original copy by using this command.    You may perform up to three edits without 
updating the file.



Save New WaveFile
This option allows you to save the current edit level that the WaveFile is at.    Use caution when implementing this 
command;    this will permanently alter your original WaveFile.    You may use this command between any edit you 
have made.    For example, you open a WaveFile, mix another WaveFile, insert a ClipArea, and decide that you want 
to save that version.    Choose this command at this time and you original version will be overwritten with the new 
edited version.



Mrk E Clip Button
Use the Mrk E Clip to specify the end of a ClipArea that you plan to create.    You must    previously have marked 
the beginning point with the Mrk B Clip button.

Mark the end point by clicking a black line into the Expanded View with your mouse.    Then, click the Mrk E Clip 
button.    The area between the specified beginning and ending points will be blackened, forming a "marked area" of 
the current WaveFile's waveform.

Since the newly marked area is in fact a pre-named ClipArea, you can preview it with the Play Marked button in the 
Manipulation Controls.    If it is unsatisfactory, you can erase it with the Clips Menu's Clear Marked Area command.
Or, you can convert it to a ClipArea with the Clips Menu's Name Marked Area command.



Play Button (Manipulation Controls Window)
The Main Screen's Play button plays the current WaveFile from the position marked by the vertical black line.    
Normally, this is from the beginning of the WaveFile.    However, you can resume from anywhere in the WaveFile 
you previously stopped at (using the Stop button) by clicking the Set Start button before resuming with the Play 
button.    Or, you can begin at an entirely different point altogether by clicking a black line anywhere in the 
Compressed View.

You may also use your right mouse button to start playback, wherever your black-line cursor is within the 
Compressed View Window.



Loop Play Button
Use the Loop Play button to initiate cyclical repetitions of the current WaveFile.    The first cycle begins from the 
location of the black line.    Use this feature to do multiple, automatic previews of the WaveFile while you watch the 
purple tracking indicator.

With the loop play function, you can quickly zero-in on a precise location and edit it, delete it, etc.    In this way, a 
combination of Phonos' features    takes out the guesswork and the endless switching that was necessary for pre-
digital editing.



Rev Clip Button
The Reverse Clip feature plays the selected ClipArea in reverse.    It has nothing to do with the current WaveFile, nor
does it have any purely practical uses.

Select the ClipArea you want to hear in reverse by highlighting it in the open ClipFile    Then, click Rev Clip.



Set Start Button
The Set Start feature allows you to resume playback from the position in a WaveFile that you last stopped at.    In 
other words, after you stop the reel motion with    the Stop button, and want to resume from the same point, mark it 
with Set Start before resuming with Play.

During playback, the purple tracking indicator moves across the waveform.    When you click Stop,    the purple that 
was drawn across the waveform disappears, except for the ending position.    Because this ending position marks the 
point where playback terminated, you can make the next playback operation start from that position with Set Start.



Trans Cursor Button
The Trans Cursor button is a Phonos exclusive, a tool that makes your editing time very efficient.    It 
instantaneously makes the black-line cursor in the Expanded View agree with the position of the black-line cursor in
the Compressed View.    This means you do not have to pinpoint the desired location with guesswork and endless 
scrolling and trolling.    When the black line cursor is in the approximate area you want to work on in the 
Compressed View, click Trans Cursor to arrive at the corresponding part of the Expanded View.    Phonos does the 
scrolling and trolling for you in a matter of milliseconds!

 Note the time position of the black-line cursor in the Compressed View by looking at the tick marks on the yellow 
time-scale indicator.    Next, click the Trans Cursor button and the Expanded View will shift the waveform to 
display a black line cursor at the corresponding position in time, except that the tick marks will be in smaller units, 
allowing for ultra-precise editing.



Mrk B Clip Button
Click Mrk B Clip to specify the beginning of a ClipArea that you plan to create.    Mark the point by clicking a 
black line into the Expanded View with your mouse.    Then, click the Mrk B Clip button.

The next step, naturally, is to delineate the end of the marked area, in similar fashion, using the Mrk E Clip button. 



Play Marked Button
The Play Marked button    plays back a marked area, or a pre-named ClipArea, that you have created in the 
Expanded View.    Because this marked area is visible in the Compressed View, the playback's    start position jumps 
to the beginning of the black marked area and the purple tracking indicator starts movement from there to the end of 
the marked area.    The Play Marked feature is essentially a previewing tool, to decide if a marked area is worth 
converting to a proper ClipArea.

This button plays back only the marked area in the Compressed and Expanded Views.    For playback of ClipAreas 
listed in the ClipFile Window, simply point to them and double-click it with your left mouse button.



Stop Button (Manipulation Controls Window)
Clicking the Stop button halts playback initiated with any of the following controls: the Play button, the Loop Play 
button, and the Play Marked button.

 An alternative method of stopping playback, at least in the case of a WaveFile, is to click your right mouse button 
anywhere within the Compressed View during WaveFile playback.



FF Button
The Fast Forward control advances the black line cursor in small jumps (not continuously, as with a true reel) in the 
Compressed View to a new position.    If FF is clicked during playback, reel motion ceases and restarts at the new, 
forwarded position.    If the control is used when there is no reel motion, the black line cursor is merely moved 
forward.



Record Button (Manipulation Controls Window)
The Record button in the Manipulation Controls is the first step to recording a new WaveFile.    It is not, however, a 
live switch; it starts no reel motion.    Instead, it opens the "Record WaveFile As..." Window, in which you choose 
the directory, drive, and filename.    After this, click OK from this box, and the    Recording Console will appear and 
the name you have given to the new WaveFile is displayed at the top.    The Record button in the Recording Console
is that which initiates reel motion.



Rew Button
Click this button to backup the black line cursor in the Compressed View to a new position in the WaveFile.    When
using this button during playback, playback is stopped and restarted at the new backed up position.    If this button is 
used when playback is stopped, the black line cursor is simply backed up to the new position.



11 kHz Checkbutton
The 11 kHz checkbutton sets a recording sampling rate of    11 kHz ("radio quality").    Sampling rate can be 
compared to your printer's "dots per inch" level.    The more dots that the printer can put in a character (e.g., a letter),
the smoother and more natural it will look.    At 11 kHz, you are instructing Phonos to use roughly 11,000 "dots" of 
the incoming sound per second.    Radio quality (11 kHz per second) uses the least amount of disk space, but also 
yields the "roughest" quality, like a letter made with too few dots.    When you click the Record button, the sampling 
rate will be set to 11 kHz and recording will begin.



22 kHz Checkbutton
The 22 kHz checkbutton sets a recording sampling rate of 22 kHz ("cassette quality").    Sampling rate can be 
compared to your printer's "dots per inch" level.    The more dots that the printer can put in a character (e.g., a letter),
the smoother and more natural it will look.    At 22 kHz, you are instructing Phonos to use roughly 22,050 "dots" of 
the incoming sound per second.    Cassette quality (22 kHz per second) uses an intermediate amount of disk space, 
but also yields an "intermediate" (or "midrange" quality).    When you click the Record button, the sampling rate will
be set to 22.05 kHz and recording will begin.



44 kHz Checkbutton
The 44 kHz checkbutton sets a recording sampling rate of 44.1 kHz ("CD quality").    Sampling rate can be 
compared to your printer's "dots per inch" level.    The more dots that the printer can put in a character (e.g., a letter),
the smoother and more natural it will look.    At 44.1 kHz, you are instructing Phonos to use roughly 44,100 "dots" of
the incoming sound per second.    Cassette quality (44.1 kHz per second) uses the most amount of disk space, but 
also yields the finest quality.    When you click the Record button, the sampling rate will be set to 44.1 kHz and 
recording will begin.



Stereo Checkbox
The Stereo checkbutton, when clicked on (with an "x"), orders a stereo setting for the WaveFile you are about to 
record.    Stereo uses double the samples per second than the mono, or unchecked setting, uses.    Samples can be 
compared to your printer's "dots per inch" level.    The more dots that the printer can put in a character (e.g., a letter),
the smoother and more natural it will look.      Stereo recording uses the extra "dots" to improve the sound quality 
with subtle audio separations, yet it takes up twice the amount of disk space. To record in mono, simply uncheck the 
box so that it is empty (without an "x").



Record/Play Indicators
The Record/Play Indicators are two digital "lights" that indicate reel motion in your Recording Console.    The 
Record button turns them red, indicating (in true studio fashion) that recording is in progress.    The Play button turns
them green, the color traditionally associated with playback.    Stopping the reel motion with the Stop turns the lights
off.    There are two lights, instead of one, to represent the two channels of stereo; however, in Phonos, both lights go
on for the mono setting as well..



Recorded Waveform View
This box displays a small waveform of the entire, newly recorded WaveFile.    Phonos does not draw this waveform 
in real time, meaning that the waveform is drawn in this window only after recording has stopped, and not during 
recording.    This waveform can be played back but not be edited here.    It is only as a visual and playback tool.

You may use this mini-waveform to preview the newly recorded WaveFile from any point within it by moving the 
scroll thumb to where you want to start and clicking the Play button.    This operation, however, is done with much 
more precision in the Main Screen.    



Recorded Waveform Scrollbar
 After recording a WaveFile, a cameo version of its waveform is written in a tiny window in the Recording Console. 
With its scroll bar, you can move through and inspect the waveform (only part of the WaveFile is visible).    You may
move the scroll thumb (by clicking on either side of it or with the two arrows) to any position and initiate playback 
with the Play button.

The point of the Recorded Waveform and its scrolling capacity is that they allow you to listen to any part of the 
newly-recorded WaveFile, instead of all of it from the very beginning.



Record Button (Recording Console)
This Recording Console's Record button is the live switch that starts the recording process.    The Record/Play 
Indicators will turn red and both the Samples and the Time Elapsed indicators will begin metering as Phonos writes 
the data to the file that you named before entering the Recording Console.



Play Button (Recording Console)
The Recording Console's Play button is used to preview a freshly recorded pre-saved WaveFile.    In studio fashion, 
it turns the Record/Play Indicators green.    Use it to determine whether or not you want to (1) save and open it to the
Main Screen, (2) re-record it, or (3) close the Recording Console without saving the new file.    Playback commences
from the marked (with the scroll thumb) position in the small Recorded Waveform Window Scrollbar.



Stop Button (Recording Console)
The Stop button serves two functions in the Recording Console.    

First, it terminates the recording session (red lights).    When you have recorded all that you want, click Stop.    The 
WaveFile is written to disk and the Record/Play Indicators go out..

Second, the Stop button    halts playback (green lights).



Close/Save Button
Use the Close/Save button to save the new WaveFile--if you are satisfied with it--as you exit the Recording Console.
It will be opened in the Main Screen just as if you selected an existing WaveFile with the File menu's Open 
WaveFile.    You may then begin editing your new WaveFile without delay.



Close/Delete Button
Use the Close/Delete button to exit the Recording Console and return to the Main Screen without the WaveFile you 
recorded, which is automatically deleted from the temporary menu.    No WaveFile, therefore, will be opened and 
written to the Waveform Views; it will be as if you just started Phonos.



Samples Indicator
The Samples Indicator shows the amount of samples (recording units) that the currently recording WaveFile uses up.
It is something like an odometer for your recording session.    Consequently, when you stop recording, this indicator 
also stops.    Use the amount to budget your available hard-disk space.    The rate at which samples are used depends 
on the sound quality and number of channels you chose in the Recording Console.



Time Elapsed Indicator
This Time Elapsed Indicator shows the length, in time, of the WaveFile as you have recorded it so far.    It is a type 
of chronometer, measuring in minutes, seconds, and hundredths of seconds.    Consequently, when you stop 
recording, this indicator also stops.



Current Midi File Indicator
The Current MIDI File Indicator tells you what    MIDI file is selected or playing, in much the same way that a 
jukebox indicates the song it is playing or about to play.



Status Indicator
The MIDI Status Indicator flashes a green Playing during    MIDI playback or a red Stopped before or following 
MIDI playback.



Open Button
This button summons a DOS window showing the various drives/directories in which MIDI files (.MID or .RMI) 
can be found.    Choose a MIDI file and click OK.



Play Button (MIDI Control Panel)
The MIDI Control Panel's Play button plays the MIDI file named in the Current Midi File slot.    If playback is 
stopped using the Stop button and then restarted with Play, the file will restart from the beginning.



Delete Button (MIDI Control Panel)
The MIDI Control Panel's Delete button irreversibly erases any currently loaded MIDI file from your hard drive.    
Do not confuse this control with the MIDI Menu's Delete MIDI File command.

The Delete button deletes the currently open MIDI file; the Menu's Delete command lets you choose MIDI files 
from your hard drive/directories for deletion.    Use both with restraint; once you delete a MIDI file, it cannot be 
retrieved.



Stop Button (MIDI Control Panel)
The MIDI Control Panel's Stop button terminates MIDI file playback and changes the status to Stopped.



Close Button (MIDI Control Panel)
The MIDI Control Panel's Close button is the only way to exit the MIDI Control Panel and return to the Main 
Screen.    Use it when you are finished playing MIDI files.



Black Line Cursors and Positions
The use of Black Line Cursors in the Compressed and Expanded Views is essential to editing and mixing in Phonos. 
For more a detailed explanation, click the items below.
    
Compressed View
Expanded View



Black Line Cursor - Compressed View
The Compressed View is a profile of the entire WaveFile, so you can see, even if only "from a distance" any point in
the WaveFile at any time.    When the waveform first appears in the two Views, the black line cursor will be at the 
beginning, on the far left at the start of the file.    Clicking Play, will therefore initiate playback from the beginning 
of the WaveFile.

To start playback from another point within the file, move the black line cursor to the desired spot and click once 
with your left mouse button. The black line will instantly shift from the beginning of the WaveFile to the chosen 
position.    Click Play to initiate playback at that point.

The Rew and FF buttons also move the black line cursor, though not continuously (like their cassette recorder 
counterparts).    You can also see the black-line cursor shift when using the Set Start button.    Too, the cursor shifts 
when you use the Play Marked button.

Use the graphics below for a demonstration for the black line cursor movement in the Compressed View.

This is the position that the cursor is in
when you first open the WaveFile.

After clicking your mouse in a new position, the original cursor is erased and redrawn at the newly selected 
position.



Black Line Cursor - Expanded View
The use of the black line cursor in this view is essential for editing sound in Phonos.    Unlike the cursor in the 
Compressed View, this cursor serves multiple purposes, as detailed below.

1.    Marking an area (name a ClipArea or delete from the WaveFile)
Point and click the desired beginning of the marked area.    A black-line cursor will appear.    Freeze this 
beginning position by clicking the Mrk B Clip button.    Then point and click the desired end of the marked 
area.    A second black-line cursor marks this point.    Freeze this ending position by clicking the Mrk E Clip 
button. The now delineated marked area is suddenly blackened.      Now, you may either name that marked 
area to save it as a ClipArea or you may delete it from the WaveFile.

2.    Inserting and Mixing
Point and click the position where you want an insertion to take place, or a mixing to begin.    A black-line 
cursor will appear.

3.    Transferring a position from the Compressed View
To view, close up in the Expanded View,    the area around the Compressed View, click the Trans Cursor 
button.    The waveform in the Expanded View shifts to show the position of the black-line cursor in that 
View.



Adjusting Marked Areas
An included bonus to Phonos' editing capabilities is the ability to adjust a marked area that you created by using the 
Mrk B Clip and Mrk E Clip buttons.    If a marked area is visible in the Expanded View and the beginning and/or 
ending positions is also visible, you may "click and drag" the beginning or ending positions to adjust the starting and
ending points of the area.    For a detailed example, see the graphic below:

First, start with a marked area in the Expanded View.

To adjust the beginning point, point to the beginning mark position, and press down with your left mouse button.    
While holding the button down, move your mouse to the newly desired sample position.    Then release the mouse 
button.    The marked area will now reflect the new position.

The same holds true for adjusting the ending position.    Note:    To adjust either position, the beginning and/or 
ending points must be visible.



Adjusting Zoom Positions
When a marked area is on the screen, you may want to have the ability to more precisely change the beginning 
and/or ending edit points than by using the Expanded View.    For example, if you want to remove a "pop" or glitch 
which you cannot see in the Expanded View, you may choose to "zoom in" on that position.    When choosing Zoom 
Marked Left or Zoom Marked Right from the Zoom Menu, the beginning and/or ending position must be visible in 
the Expanded View, respectively.    If visible, the respective window appears.    If the left option is chosen, you see 
half of the window "blacked out" from the center to the right, indicating the beginning of the marked area.    
Likewise, if the right option is chosen, you see half of it's window "blacked out" from the far left to the center, 
indicating the ending of the marked area.    You are now able to see in great detail the samples that surround the 
beginning and/or ending positions in the Expanded View.    As with the Expanded View, you are able to "point and 
drag" this sample position in each of the zoom windows to adjust it's position.    For a detailed example, see the 
following graphic:

Notice the corresponding positions and samples that surround the ending mark in the right zoom window.

You may then adjust the position by "pointing and clicking" with your left mouse button.    Hold the button 
down and move it to a new position.    Release the button and see the area in the zoom window redrawn.



Test the new marked area by pressing Play in the Zoom Controls Window.    Playback can be stopped by pressing 
Stop.    If you are satisfied with the new position, press OK.    If not, you can continue to edit, or press Cancel to 
cancel the zoom operation.
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Creating WaveFiles
 A WaveFile is like a document that is first written and then rewritten as many times as necessary to arrive at the 
polished, finished product.    Each revision, from first to final, is called, of course, a draft.    In the same way, 
WaveFiles are drafts, but they are recorded rather than written.      Most of what Phonos is about is the editing of 
these audio "drafts."

However, before the editing, or "rewriting," can proceed, the original must be made.    The procedure is easy and is 
patterned on the familiar cassette player.    To create your first draft of a WaveFile, you start from the Main Screen 
and follow these simple steps:

1.    Click the Record button - (the "Name WaveFile As..." window appears).

2.    Give the WaveFile a name, by typing up to eight characters.    Press OK - (the Recording Console 
Appears).

3.    Click the Record button to activate the actual recording function.    The red lights indicate that a 
WaveFile is being recorded.

4.    Click the Stop button to stop the "reel motion."    Your WaveFile now exists in a temporary file on your 
hard drive.

Was that not simple?    To test and keep this first WaveFile draft, you should test it at least once and then save it, as 
per the next two steps.

5.    Playback your WaveFile with the Play button.    The green lights will go on as the newly created 
WaveFile is played back.

6.    Save or delete your WaveFile with the Close/Save or Close/Delete button, respectively.    If you elect to 
save, the Main Screen will appear and your new WaveFile will be opened just as if you had chosen the 
Open WaveFile command from the File Menu.    It is now ready to be edited into the next draft.    If you 
elect to delete, the WaveFile is erased and you are returned to the Main Screen with no current WaveFile 
open.



Main Screen Scroll Bar - Expanded View
This scroll bar, found at the base of the Expanded View Window, is used to move you through the current WaveFile 
waveform.    Because the Expanded View Window displays a "zoomed in" view of a section of waveform at any one 
time, you need a method of shifting that waveform so you may see and be able to edit different sections.    The scroll 
thumb may only be moved by using the far left and right arrows.    This limitation requires you to move through the 
waveform in small increments, which can seem to be a long process if the current WaveFile is lengthly.    However, 
you may make a long jump to another location in the waveform by using the Trans Cursor button in the 
Manipulation Controls Window.



ClipFile Window Scroll Bar
The scroll bar in this window is dependent on the number of ClipArea names that are present in the ClipFile 
Window.    If you are running Windows in VGA mode (640 x 480), up to four ClipArea names will fit within the 
ClipFile Window before a vertical scrollbar is visible.    To accommodate five or more ClipArea names in this 
window, a vertical scroll bar appears that you can use to scroll through names that are not visible.

Notice that since there are only three
ClipArea names in the window, no vertical
scroll bar is present. 

This is the same list with 2 extra ClipArea
names - which adds a vertical scroll bar
so you may see all names in the window.



Volume Adjustment Window Scroll Bar
This scroll bar is used to adjust the percentage of volume increase or decrease.    This scroll bar can be moved in 
three different ways.    First, you can use either of the arrows on the ends of the scroll bar to increment (or 
decrement) the percentage by 1 unit at a time.    Second, you can point to the scroll thumb and, while holding your 
left mouse button down, you can drag the scroll thumb to the right or left to increase (or decrease) the percentage by 
1 unit on each movement.    Third, you can point and click with your left mouse button anywhere within the scroll 
bar and the percentage will increase (or decrease) by 10 units per click.



Attributes Window Elements
This window describes certain quantifiable characteristics, or "attributes," of the current WaveFile.    It is an 
indicator window only, showing the results of the manipulations you have performed and the parameters you have 
set.    Use the graphic below to obtain help on each of the Attributes Window Elements.    Simply point and click on 
the desired item to receive detailed information.



WaveFile Name
This line shows the name of the current WaveFile, including the extension, which will be .WAV or    .CPA (if you 
opened a ClipArea as a WaveFile).



Space Occupied On Drive
This line shows the size, in bytes, of the currently open WaveFile; in this case, 222,000.    This number represents the
amount of hard disk space that the WaveFile takes up.



Attributes Sampling Rate
This line indicates the sampling rate selected (in the Recording Console) for the current WaveFile.    A sampling rate 
is the number of "snapshots" (units of reel space, essentially) that are taken per second of recording.    In this case, 
the cassette quality, which takes about 22,050 "snapshots" per second, was selected.    The quotient you get by 
dividing the number on the line above (Space Occupied) by this number is, therefore, the length of your WaveFile in
time.    This WaveFile, then, is about 10 seconds long.    If, however, two channels were selected (stereo option) 
instead of one (mono) as is the case here, you would have to further divide by two to get (in this case) a WaveFile 
with a duration of about five seconds.    A more direct way of knowing WaveFile length, of course, is to simply look 
at the "end of the ruler," so to speak, which lies in the yellow time indicator bar under the Compressed View.



Bits Per Sample
This line indicates the number of bits per sample that are used by your sound hardware during recording.    It will be 
either 8 or 16.    Currently, Phonos only supports recording 8-bit samples.    However, future versions of Phonos will 
support 16-bit recording.    You may, however, playback 16-bit WaveFiles that were created from other sources.



Number of Channels
This line shows the number of channels the current WaveFile was recorded at. Phonos gives you the option of one 
channel (mono) or two (stereo).    In the case of this Window, one channel (mono) was selected when the WaveFile 
was recorded.





A word that describes any pre-digital method of recording.    Analog 
systems use a physical medium of one type or another, such as vinyl 
phonograph records, compact discs, or some kind of magnetic tape.



In Phonos literature, this term is often used as a generic category that 
includes all user-recorded audio files: WaveFiles and ClipAreas, but not 
MIDI files.



Custom-point mixing blends a copy of a WaveFile from the WaveFile 
directory with    whatever point (in the time scale indicators) of the 
current WaveFile that you mark with the blackline cursor.    It    is then 
completed by clicking the File Menu's Open WaveFile command, 
selecting the other WaveFile, and clicking OK..    The result can be 
saved with the Edit Menu's Save New WaveFile command.



Zero-point mixing is the easiest and most automatic form of mixing in 
Phonos.    It mixes a copy of a WaveFile from the WaveFile directory 
with the beginning, or zero point (in the time scale indicators) of the 
current WaveFile.    It is performed by clicking the File Menu's Open 
WaveFile command, selecting the other WaveFile, and clicking OK..    
The result can be saved with the Edit Menu's Save New WaveFile 
command.



The purple tracking indicator is an editing aid that moves across your 
Compressed View during playback.    It is useful in monitoring the 
playback over the time scale indicator to zero-in on the approximate 
location of the WaveFile that you want to edit.    Use your ears to listen 
for the location, use your eyes (by eyeing the purple tracking indicator)
to watch for it.    When you terminate reel motion, the indicator 
converts to a vertical line of the same color, to mark the stopping 
point.



The discrete unit or the "atom" of    information stored in the 
computer's memory.    A bit may have a digit of 0 or 1 (hence the name
"digital"). The unique arrangement of 0-bits and 1-bits is the stuff of 
any digital file, including Phonos' audio files.    The more bits that are 
used in a WaveFile, the more detail it contains, though with the 
consequence that the supply of bits is more quickly exhausted.    The 
sampling rate is the rate at which bits are used.



In the Phonos context, a channel is the left or right side of a stereo 
system.    A WaveFile recorded with the stereo option (chosen in the 
Recording Console's Preferences box) occupies exactly double the 
space that a one-channel (mono) recording occupies.



A ClipArea is a segment of a WaveFile that comes into existence the 
moment it is defined by marking its beginning and end points with the 
manipulation controls on the Phonos Main Screen, then named, saved, 
and sorted into a ClipFile.



A ClipFile is "folder" in which one or more ClipAreas is stored.    To exist,
a ClipFile must be given an eight-character (or shorter) name with the 
Save ClipFile command and it must hold at least one ClipArea.    A 
ClipFile may be sorted into any directory you choose.    The ClipAreas in
a ClipFile may or may not otherwise have anything to do with each 
other.



This, the smaller of your two Waveform Data views, contains a profile 
of the entire current WaveFile and is used to navigate within the 
Expanded View, where you will do your editing.    The blackline cursor 
and the current ClipArea are visible in their positions, relative to the 
entire WaveFile.    You cannot edit in the Compressed View.



To erase, or "clear" a marked area is to throw it away before it is 
named and saved as a ClipArea (as opposed to the more involved 
process of deletion, which is throwing away a named, saved ClipArea).



This command, activated from the Main Screen's Manipulation 
Controls, causes a WaveFile of any length to automatically replay over 
and over without stopping, until you click the Stop button.    It makes 
multiple playbacks possible without performing the stop/rewind/play 
cycle for each replay.



An acronym for Musical Instrument Digital Interface, a    language 
which only your computer understands that enables it to accept input 
from other digitalized recordings or directly from an electronic 
instrument.    Phonos can "speak" this language to the extent that it 
can accept files recorded, at some point in their history, with MIDI, and 
play them back.



A single-channel recording mode; a    method that produces recording 
not separable into subtly different sound patterns.    In Phonos, a 
WaveFile recorded at mono will produce identical sounds from both 
speakers, when played back.    It occupies half the disk space of 
recordings made with stereo mode.



Time Scale Indicators are the horizontal yellow bars visible under the 
Compressed and Expanded Views.    They are basically rulers whose 
tick marks show how far you are, in terms of time, from the beginning 
of the waveform (and, therefore, the WaveFile).    The longer your 
WaveFile is, the more time there will be between the tick marks.    The 
Compressed View's time scale indicator does not change because it 
must run the entire length of that WaveFile, and it automatically shifts 
from left to right as you shift the horizontal scroll thumb from left to 
right (and vice-versa).



Stereo, in Phonos and elsewhere, is the dual-channel recording mode; 
a method that produces recordings that are separable into subtly 
different channels.    In Phonos, a stereo-recorded WaveFile, when 
played back, will be acoustically different between the two speakers.



The Trans Cursor button causes the area around the blackline cursor in 
the Compressed View to be instantly moved to the center of the 
Expanded View.    You use it to expedite your editing or close-up 
inspection of any segment of the waveform.    The Trans Cursor button 
is a Phonos exclusive, an editing tool unique in the world of desktop 
audio production.



In Phonos, Sampling rates are the three levels of audio quality at which
a WaveFile can be created.    They correspond to different parts of the 
radio spectrum and are measured in megahertz (MHz).    The highest 
level, called "compact disk " (CD), is rated at 44.1 MHz and consumes 
the largest amount of hard-disk space.    The lowest ("radio") is rated at
11 MHz and consumes the least amount.    The midrange ("cassette") is
rated at 22 MHz.



A WaveFile is a computer document that is analogous to a recording on
a tape reel, phonograph record, etc., except that it can be manipulated
much, much more easily and with greater precision.



Waveforms are the visual expressions---compact and expanded---of a 
WaveFile that is used to navigate about the recording and to 
manipulate and edit the recording itself.    Long before the new era of 
digital audio editing, there were waveforms (e.g., on radar screens and 
analog-based audio equipment), but they were only indicators.    In 
Phonos, the user can all but reach into the screen and manipulate this 
signal at will to alter the recording (WaveFile) it represents.



Deletion is the process of discarding a saved file, whether that file be a
ClipFile, a WaveFile, or a MIDI file.    Also, for purposes of Phonos' 
memory management, a single ClipArea is also a file, although the user
need not think of it as such.    Deletion is a destructive process that 
erases any of these entities from Phonos' permanent memory, as 
opposed to erasure or "clearing," which erases an unnamed ClipArea 
(and nothing else) from Phonos' temporary memory.
A separate type of deletion, a nonfile deletion, takes place when the 
Delete Marked Area command is used.



The Expanded View is the larger of your Main Screen's Waveform Data 
Views, and the one where the actual manipulations take place.    In 
digital technology, the Expanded View replaces both the reel tape and 
the primitive electronic screen function of analog-era equipment.



Phonos' midrange sampling rate.    The name has nothing to do with 
real cassettes, but only expresses the idea that cassette-recordings, as
well as most other analog-based recordings, are inferior to CDs but 
better than the broadcast recordings heard on the radio.    The cassette
rate corresponds to 22 megahertz.



A file is an entity in a computer directory. When a file is deleted, it is 
erased from the directory it was in. There are several types of files in 
Phonos, each identifiable by a three-letter suffix, or "extension," which 
is not unlike an area code in a phone number. 



The various kinds of files in Phonos have extensions, in the form of 
three-letter suffixes, to indicate the directory they are found in.    A file 
is given its extension automatically when it is added to Phonos' 
memory.    Wavefiles have .WAV; MIDI files, MID; ClipFiles,.CPF; and 
ClipAreas, which are not called files but in fact really are (so that the 
user can edit them as WaveFiles, if desired) have the extension .CPA.



DOS is the world's most widely sold software.    It performs all the 
unglamorous functions necessary to support Windows applications.    
DOS is somewhat like a hallway full of doors, each of which leads to a 
room (a file) or an entire new hall (a subdirectory) which in turn can 
lead to more new rooms or halls.    DOS expands to meet your needs in 
that each name you type after the c-prompt opens a door to such a 
"room" or "hallway".    The rooms, or files, have names of up to eight 
letters, plus an extension of three letters to identify the type of file in 
question.    See also the DOS Primer in the Help File's list of topics.



A collection of bits that contain a recording.    When you record a 
WaveFile, these samples are written to the computer's memory at 
three possible rates: CD, cassette, and radio, which are symbolically 
named to indicate relative quality.    The higher the rate, the more bits 
(of hard disk space) are used in the recorded sample.



Phonos has a play function in its Main Screen, in its Recording Console, 
and in its MIDI Panel.
In the Main Screen, the Play button    plays back a WaveFile from its 
beginning, unless you have previously marked another point (during a 
previous playback) with the SetStart button.    In that case, the Play 
button resumes playback from the marked position.
In the Recording Console, the Play button replays a pre-saved 
WaveFile from the beginning (only) for previewing purposes.
In the MIDI Control Panel, the Play button plays back a MIDI file from 
the beginning if you have previously stopped it with the MIDI Stop 
button.



A button that, in the Main Screen, opens a window in which you will 
give the WaveFile you are about to create a name of up to eight letters.
After this naming, an OK button takes you to the Recording Console, 
where the Record button again appears, this time as the switch that 
starts the actual reel motion for recording (and turns the play indicator 
"lights" red).



A Main Screen control that quickly moves the Compressed View's 
cursor to a desired area within the WaveFile.    The cursor's movement 
is in jumps, not continuous reel motion.    Click FF to go forth in this 
manner, and  Rew to go back in the same manner.    Both buttons 
parallel in function to their cassette player functions.    Use both 
buttons together to move about rapidly in a WaveFile.



A Main Screen control that quickly moves the Compressed View's 
cursor to a desired area within the WaveFile.    The cursor's movement 
is in jumps, and not continuous.    Click Rew to go back in this manner, 
and  FF to go forth in the same manner.    Both buttons parallel in 
function to their cassette player counterparts.    Use both buttons at the
same time to move about rapidly in a WaveFile.



A Main Screen control that plays back the current ClipArea.    For an 
effective looping of a ClipArea, simply leave the cursor on this button 
and click the mouse as many times as desired.    This replaces the 
imprecise and treble action of "stop/rewind/play" that one must do to 
edit a segment of a reel.



Phonos' volume adjustment feature is not merely a knob you    turn 
while playing back a recording, but an actual editing capability.    You 
can decrease the volume down to 1% of the original or increase it up to
100% .    Larger increases require additional uses of the Volume Menu's 
commands.      Adjusting ClipArea volume is completed within the 
Increase and Decrease Volume dialog boxes, but adjusting a WaveFile 
requires an additional step, the use of the Save Adjustments 
command.
To review the three ways of making volume adjustments, see the entry 
for "Scroll bars" in this glossary.    See also the caution in Chapter Six of
the User's Guide under Decrease [Clip Area].



Phonos lets you adjust the volume of a ClipArea or WaveFile up or 
down.    Both commands open a box with the same name that allows 
increases up to 100% or decreases of down to 99% of the original.    
When adjusting a ClipArea, the change is permanent when you click 
OK in the box.    When adjusting a WaveFile, you must use the Edit 
Menu's Save New WaveFile command to make the change permanent.



.WAV Filename Extension
This file label .WAV is the standard three-letter extension recognized by all Windows-based multimedia audio 
programs.    Any WaveFile created in Phonos will have the .WAV extension on the end and can therefore be used in 
other Windows-based audio programs.      Microsoft has included four sample WaveFiles on your Windows 
installation diskettes; they can be found in your WINDOWS directory.    You can open these files in Phonos with the 
Open WaveFile command in the File Menu, as with a WaveFile that you have created yourself.



.MID Filename Extension
The file label .MID is one of two standard three-letter extensions recognized by the MIDI Mapper in your Windows' 
(not Phonos') Control Panel.    When you obtain MIDI files from various sources, the presence of this extension 
ensures that they will be compatible with Phonos' MIDI Control Panel.



.RMI Filename Extension
The file label .RMI is one of two standard three-letter extensions recognized by the MIDI Mapper in your Windows' 
(not Phonos') Control Panel.    When you obtain MIDI files from various sources, the presence of this extension 
ensures that they will be compatible with Phonos' MIDI Control Panel.



.CPA Filename Extension
The file label .CPA identifies ClipArea Files, and is therefore exclusive to Phonos.    ClipAreas are created with the 
Name Marked Area command in the Clips Menu.    When you name the marked area and press the OK button, the 
name you enter appears in the ClipFile Window.    This adds    the .CPA extension to the name you gave to the 
marked area, and saves the sound within the marked area in the file.    In essence, a mini WaveFile is created.    For 
example, if you have named a marked area "DRUMS1", it is instantaneously    saved to your hard drive as 
"DRUMS1.CPA".    Since ClipAreas are actually small WaveFiles, you may also edit them as you would any 
WaveFile.    For information on doing this, see Opening ClipAreas as WaveFiles.



.CPF Filename Extension
This file label may be thought of as a file folder.    The .CPF extension tags a file as a ClipFile, a folder created to 
hold one or more ClipAreas. This filing system, the ClipFile concept, is a Phonos exclusive.    When you choose the 
Save ClipFile command from the Clips Menu, you are prompted to a name the ClipFile to be saved.    After clicking 
the OK, a .CPF extension is instantly added to the end of the name and saved to the same directory together with the
ClipArea(s) that are in it.    ClipFiles actually contain only the list of the ClipArea(s) they contain, not the actual 
sound data from each ClipArea.    This allows you to work separately on each ClipArea, without disturbing the 
overall ClipFile that it resides in.



.INI Filename Extension
This file type is common to many Windows-based programs.    It contains default information that programs read at 
execution.    In your Windows directory there are several .INI files.    Phonos uses its own .INI file (PHONOS.INI), 
to hold certain configuration preferences you have chosen as your preferences.    For more information on creating 
PHONOS.INI and changing the values contained therein, refer to Save Preferences.



The lower-left corner of your "DOS windows" has a box you can use to 
select audio file types: WaveFiles (.WAV), ClipFiles (.CPF), MIDI files 
(.MID or .RMI), and ClipAreas (.CPA).    Whenever you select    one of 
these types in the lower-left DOS box, its three-letter extension 
appears over the upper-right DOS box, heading a directory of all the 
files of that type.    You can now choose files from this directory for 
opening, deletion, etc.      For definitions of file types, see their 
individual entries.



Almost all PCs, as you know by now, have (at least) "a, b, and c" 
drives, the first two being the retrieval and input mechanisms for the 
two sizes of floppy disks, and "c" being that for the permanent disk 
that is part of your computer.    For Phonos users, this is relevant 
whenever it is time to determine the destiny of a new ClipFile or 
WaveFile.    Most of the time, you will have the "c" drive selected in 
your DOS program so that your work will be stored in the PC.    If your 
hard drive is "partitioned" into two or more subdrives (e.g., "c and d" or
"c, d, and e"), you may choose to set aside an entire free drive 
exclusively for Phonos.



The echo is a sound effect, or a specialized type of mixing, that 
produces a "reverberation" by mixing a copy of a WaveFile or ClipArea 
with itself, but with the copy very slightly advanced.    You can perform 
trial echoes with the Mix Menu's Echo WaveFile command.    Save the 
result, if desired, with the Edit Menu's Save New WaveFile command.



Multimedia cards are specialized, bolt on hardware that are needed in 
certain specialized applications.    In the case of Phonos, it is an audio 
card that provides the additional medium (sound) to the visual medium
already present in your PC, hence the name multimedia; a sound card 
converts your computer from a single medium (visual) to multimedia 
(audiovisual).    Phonos accepts any Windows-compatible sound card 
that supports 8- or 16-bit samples in stereo or mono.



Midrange is the arbitrary, qualitative name given to Phonos' 
intermediate sampling rate (22 kHz), which is also called "cassette 
quality."    It is selected in the Recording Console.



The Main Screen is your editing and mixing station, as opposed to the 
Recording Console (which is your recording station).    It has six 
"windows."    These windows work in conjunction with one another so 
you may edit your WaveFiles efficiently.



MRK B CLIP solidifies the beginning of a ClipArea    that you have 
already marked in the Expanded View with your cursor.    If you have 
not previously marked a beginning point, this control is not enabled.



MRK E CLIP solidifies the end of a ClipArea that    you have already 
marked in the Expanded View with your cursor, and causes the 
ClipArea-to-be to appear in black.    If you have not previously marked 
an ending point, this control is not enabled; nor does it do anything if 
there is not also a beginning for the ClipArea.    To make this marked 
area into a true ClipArea, you must name and save it.



In audio contexts, a medium is where recorded information is stored.    
There are two kinds: analog and digital.    Analog media, such as 
magnetic tape and vinyl disks, are physical and thus store information 
by being physically modified.    Digital media, such as your computer's 
memory, are arrangements of two digits, 0 and 1, in combinations 
within a computer's memory.    To take the analogy a little further, the 
combination of a lock that you buy is originally recorded on an analog 
(a tag of paper).    But this is thrown away once you have "digitally" 
memorized the code.



A marked area is the precursor to a ClipArea; it is a ClipArea that has 
not been named and saved, yet nevertheless appears as a blackened 
region within the current WaveFile.    You create a marked area with the 
MRK B CLIP and MRK E CLIP buttons in your Main Screen's 
Manipulation Controls.    The removal (erasure) of unsatisfactory 
marked areas is called "clearing."



Phonos' MIDI Control Panel is where you execute all MIDI-related 
commands, except for selecting the actual recording to be played.    If 
you use your Phonos-equipped PC as a jukebox, you can think of the 
Open button as an "on-switch" that illuminates the song menu;    the 
Play button as an endless role of quarters with which to operate the 
mechanism; the Stop button as an emergency brake if you change 
your mind about a song while it is playing; the Close button as the 
"off-switch"; and the Delete button as a key you open the record 
compartment with to remove a record you are tired of.



A MIDI file is a pre-recorded audio file that is imported to your hard 
drive and filed with the extensions .MID and .RMI, depending on the 
source of the disk that was sold to you.    That your MIDI files can have 
one of two extensions is of no consequence; you can pretend they are 
one (although DOS will sort them into different directories).    MIDI files, 
unlike WaveFiles and ClipAreas, consume very little hard drive space 
because they are not written as waveforms.    You can therefore store 
thousands of them easily.



The hard drive, which is drive "c" in all PCs (though there may be 
additional ones, such as "d"), is the mechanism that holds the medium 
of your computer's permanent memory, the "hard disk."    Whenever 
anything is saved in Phonos, be it automatically or via an explicit 
command, it is placed here.    The capacity of a hard disk/drive is 
measured in millions of 8-bit "bytes" (megabytes).    The number of 
bytes that are used in the creation of your current WaveFile can be 
seen in the WaveFile Attributes Window, and this can be used to 
budget your hard disk space.



In Phonos contexts, an indicator is any part of    the program's 
instruments that is not an actual tool, but merely shows something.    
These include the Play Indicator lights, the Recording Waveform, the 
Samples and Time Elapsed meters in your Recording Console; the 
entire Loop Play Statistics and    WaveFile Attributes Windows; and the 
MIDI Panel's Status indicator.    Indicators are not concerned with actual 
manipulations, but with their results.    For more information on 
individual indicators, see their entries in this glossary.



The menu bar is the topmost Window in Phonos' Main Screen.    There is
also a smaller one over your MIDI Control Panel.    Menu operations, in 
Phonos literature, are called commands.



Attributes are a series of parameters concerning WaveFiles.    They are 
seen in the WaveFile Attributes Window.    Aside from the name of the 
current (visible on the Main Screen) WaveFile, the attributes concern, in
one way or another, the amount of memory used by the WaveFile, 
although they also express important qualitative information, such as 
reminding the user of the number of channels and the level of audio 
quality (sampling rate) that were chosen as recording options in the 
Recording Console.    Each attribute has an entry in this glossary.



Your PC has two types of memory: permanent ("hard drive" or "hard 
disk space") and temporary (RAM or "system memory").    Both are 
stored as bits of information, namely a digit of either "0" or "1".    IQSoft
recommends, as a minimum,    120 million bytes of permanent memory
and 4 million bytes of temporary.    The permanent memory is the home
of all your saved material, and the temporary (which would be 
automatically lost in the event of, say, a blackout) holds your marked 
areas before they are named as ClipAreas, then saved and sorted, and 
a newly recorded, adjusted, or modified WaveFile (one that is pre-
saved.) 



The Manipulation Controls are the twelve buttons that appear in the 
middle of your Main Screen.    The top row is concerned with recording 
and perform essentially the same functions as the familiar controls 
found on any cassette player.    The bottom row is concerned with 
editing and mixing your recordings.



Moving, in Phonos literature, refers specifically to the duplication of 
existing ClipAreas and changing their position within a WaveFile or 
transporting them to another WaveFile.    These processes formerly, 
prior to the advent of desktop audio production, were laborious, 
inexact, and otherwise problematic.    Phonos lets you perform such 
operations almost effortlessly, and the result is seamless and 
amenable to further easy modification.



Naming in Phonos is really a form of labeling.    It is also the only time 
you will ever use a keyboard.    WaveFiles are named between the two 
Record buttons: that in the Main Screen which opens the "Record 
WaveFile As..." Window, and the live switch in the Recording Console 
that you initiate the actual recording with.    ClipAreas are named in a 
special dialog box that is opened with the Clips Menu's Name Marked 
Area command, and ClipFiles are named whenever you have a newly 
made ClipArea that is not sorted into an existing ClipFile.
In times past, naming was a bothersome task, involving the labeling of 
jars or drawers instead of digital ClipFiles, reels instead of WaveFiles, 
and bits of tape instead of ClipAreas.    Desktop audio production has 
changed all that.



In the highest levels of    professional audio editing, up to 64 channels 
are available for live stage presentations with as many speakers.    
There are software programs costing several hundred or thousands of 
dollars that have this many, though after two channels (stereo) or, at 
most four (quadraphonic), the point of diminishing returns is quickly 
reached.    Most Phonos users will not find it practical to have the 
additional speakers needed for the additional separations afforded by 
the extra channels, so Phonos offers up to two channels.    When stereo
is selected, hard drive space is used up twice as quickly as when mono 
is selected.



To convert a marked area into a stored ClipArea, it must first be named
with the Clip Menu's Name Marked Area command so that it can then 
be sorted into a ClipFile and retrieved when needed, using its name.



In Phonos, Open always refers to the opening of a directory of some 
kind.    The WaveFile and ClipFile directories are opened with menu 
commands, and the MIDI directory is opened with a button on the MIDI 
Control Panel.    The two menu commands are those that you will 
probably use more than any others.    Accordingly the top command in 
the File Menu is Open WaveFile and the top one in the Clips Menu is 
Open ClipFile.



In Phonos, playback refers to the reel motion initiated by clicking any 
of the three Play buttons, or by double-clicking any ClipArea in the 
current ClipFile (to hear it).
Playback is your method of previewing recordings, notably in the 
Recording Console, so that you can decide whether to keep it or not.    
It can also be used to do an "audio inventory" of the current ClipFile.    
The rest of the time, of course, playback is done simply to enjoy a 
successfully edited WaveFile or a MIDI tune in your "jukebox."    
Playback is the reel motion that is traditionally associated with the 
color green, hence the green play indicators in the Recording Console.



Phonos has three Play buttons.    Each is a live switch initiating    
playback in Phonos' control/command centers (Main Screen, Recording 
Console, and MIDI Panel).    Each can be found and are described in 
detail in the Contents page of this help file.



Pre-digital studio equipment had lights to indicate reel motion.    They 
were red during recording and green during playback.    Phonos' 
Recording Console recalls this convention by having the two little 
indicator lights go red, green, or dark, as appropriate.



Reel motion is the generic term describing all functions in Phonos that 
have a "reel-moving" counterpart among the analog recording 
systems.    These include all of    Phonos' Play buttons, Fast-Forward, 
Rewind, Reverse Clip, Loop Play, and the Recording Console's 
Record button.    The Record button in the Main Screen is not a "live 
switch" because it does not directly initiate reel motion.    All Stop 
buttons in Phonos terminate reel motion.



There are two Record buttons in Phonos.    Between them, they do 
what the Record function of an ordinary cassette recorder does (except
that you do not have to simultaneously click Phonos' Play button!).    
These two Record buttons, in the order you will encounter them, are in
your Main Screen and your Recording Console.    The former opens the 
"Record WaveFile As..." Window, where you name your WaveFile before
being taken to the Recording Console, where the other Record button 
is the actual live switch, that begins the "red-light" recording session.



Radio is an arbitrary, qualitative name given to Phonos' lowest 
sampling rate, which you    select in the Recording Console.    It is called
this because recordings heard on the radio are generally of lower 
quality, through distortion or distance, than those heard "in person."    
This rate uses the least amount of hard drive space and corresponds to
11 megahertz.



The Reverse Clip control plays the current ClipArea in reverse.    While 
this audibly plays the ClipArea in reverse and is therefore a type of reel
motion, it does not, because of the nature of digital recording media,    
literally rewind the ClipArea.    One reverse clip playback can thus 
follow another without the delay and inconvenience of rewinding.



The Recording Console is where you do all of your recording in Phonos, 
save for the importation of MIDI files.    To reach it, you click the 
Record button in the Main Screen, name the WaveFile you are about to
record/create, and click OK.    The Recording Console is made up of 
indicators and controls that reflect Phonos' professional heritage.    
Each element of the Console has an entry in this glossary.    For an 
overview, see Section 2.3 of the Phonos' User's Manual.



The Recorded Waveform is a miniature waveform data view, modeled 
after the two principle Views found in the Main Screen.    It's primary 
function is to show newly recorded waveform in the Recording Console 
before making a decision on whether to save or delete the new file.    
Playback, initiated by pressing the Play button in the Recording 
Console, begins from the scroll thumb position at the bottom of the 
window.    To start playback from the beginning, position the scroll 
thumb to the far left; to start from the middle, position it in the center.



"Record WaveFile As..." is a DOS-based window brought to the screen 
whenever you click the Main Screen's Record button.    It is here that 
you type in a name, of up to eight characters, for the WaveFile you are 
about to record/create.    After the naming, click OK to get to the 
Recording Console.



Recording options are two choices you make in the Recording Console 
before recording a WaveFile, although you can set and save defaults if 
you habitually use the same options with the File Menu's Save 
Preferences command.    You will select (1) a sampling rate of 11, 22, or
44.1 kHz and (2) mono or stereo.    The higher the sampling rate and 
number of channels, the better    sounding the recording will be, 
although    more of your    disk space or memory will be consumed.    
Phonos comes with a preset default of 11 kHz ("Midrange" or "cassette 
quality") and mono.



Splicing is a term that, prior to desktop audio production, was much 
used but is now virtually obsolete.      Predigital editors had to use a 
small device, a splicer,    to mechanically join the severed ends of a reel
that was cut so that something could be taken out or inserted.    In 
Phonos, splicing is a totally painless, instantaneous, and automatic 
process that happens each time the Insert ClipArea and Delete Marked 
Area commands, and some of the mixing commands, are used.



Samples can be compared to frames in a motion picture reel.    In the 
motion picture industry, 16-frames per second go into every second of 
time; this is a sample.    In Phonos, there are three choices as to the 
size of a sample (which is composed of bits rather than frames), so we 
speak not merely in terms of samples but rates of samples, or 
sampling rates, of which Phonos offers three to choose from in the 
Recording Console.



Saving, in all computer systems, means recording a document from the
computer's temporary memory or a floppy disk to its hard disk drive.    
In Phonos, this means adding a WaveFile to the permanent memory 
with the Close/Save button in the Recording Console.    It also includes   
the saving of an edited version of a WaveFile. 



If you habitually use the same set of preferences, you can save them 
as a group of defaults (automatic settings) with the Save Preferences 
command.



There are four Stop buttons in Phonos.    Each one is used to terminate 
continuous reel motion (though not rewinding and fast-forwarding).    
Refer to the Contents page of this help file for detailed information on 
each of the various Phonos Stop Buttons.



This Main Screen control is used when you want to resume playback 
from the position, within a WaveFile that you last stopped it, instead of 
from the beginning.      To stop and resume from anywhere other than 
the beginning, therefore, you will click Set Start after clicking Stop (or 
before clicking Play.)



Scroll bars are at most tools and at least indicators that are a regular 
feature of DOS/Windows-based software programs.    In Phonos, they 
are found in your DOS window boxes, the Adjust Volume boxes, the 
ClipFile Window, and the WaveForm Views, including the Recorded 
Waveform Window in the Recording Console.



A scroll thumb is the small square that is sometimes a manipulable 
part of a scrollbar and sometimes only the moving portion of an 
indicator.    You can move, with your mouse and cursor,    the scroll 
thumb within the scroll bars found in the Adjust Volume boxes, the 
ClipFile Window, the DOS directories, the Expanded View, and the 
Recorded Waveform Window (in the Recording Console).    The scroll 
thumbs in Phonos' four Waveform Views (including the small one in the
Recording console) are place markers only.



Saving a ClipFile is actually the resaving of a ClipFile that you do when 
the ClipFile has been altered by the addition of a new ClipArea.    As 
such, the Save ClipFile command is the one you use to save ClipAreas, 
which are not saved individually but as parts of whatever ClipArea you 
have sorted it into.



"Space Occupied on Drive" is a WaveFile parameter that indicates how 
much of your computer's memory is taken up by the current WaveFile.  
It is quantified in bytes, which are clusters of    8 bits, which are the 
audio building blocks that make up the WaveFile.    This figure can be 
compared with your PC's total memory capacity.



For questions regarding Phonos, you may write us at 41800 Enterprise 
Circle South, Suite H, Temecula, CA, 92590, or call at (909) 695-1744 or
(909) 695-1747 (fax).    Please include the number of your copy of 
Phonos with your inquiry.



The Time Elapsed meter in the Recording Console is a stopwatch that 
indicates the length in time of your recording.    The time is computed 
by Phonos from the number of bits consumed while the recording 
indicators are red.



A widget is an imaginary commodity that can be compared to a 
WaveFile.    ClipAreas are Widget parts, and ClipFiles are bins containing
these parts.



A directory, in DOS usage, is not only a list of the contents in a DOS filing 
cabinet, but the contents of the cabinet as well; the mere act of pointing to and 
clicking a name in a DOS directory is all you need to do to get at the document 
(or, in Phonos, the sound file) it represents.    These directories are found in the 
"DOS boxes" within "Open," "Delete," "Save As...", "Record As..." and other DOS 
windows.    Phonos uses an automatic filing system that assigns special suffixes 
(extensions) to identify files by the directories they belong to.    The principal 
ones in Phonos are .WAV for the WaveFile Directory and .CPF for the ClipFile 
Directory.    Among the others is the .CPA Directory, for individual ClipAreas.    It is
not necessary to think of ClipAreas as proper files (though they technically are) 
unless you want to promote a ClipArea to a WaveFile by adding it to the .WAV 
Directory.      MIDI files are sorted by Phonos into either .MID or .RMI Directories, 
depending on their source, but this does not affect their utility in any important 
way.



A byte is a bundle of eight bits, or an "eight-pack" of bits (see entry in 
this glossary), and is the unit with which both temporary memory (RAM
or "system memory") and permanent memory (hard disk space) are 
quantified.    IQSoft recommends 120 million bytes for the former and 4 
million bytes for the latter.    The "Space Occupied on Disk" parameter 
in your WaveFile Attributes Window (Main Screen) can be compared 
against your total memory capacity, so that you can budget your 
bytes.



The blackline cursor is a tentative chalk mark that you make in a 
WaveFile to delineate the beginning and end of a marked area that will 
be named and saved as a ClipArea.    You put it in place with your arrow
cursor and a single click of your mouse.    Clicking anywhere else in the 
WaveFile shifts it to that point. To make the marks permanent, click the
MRK B CLIP button after you mark the beginning with the blackline 
cursor, then do the same with the MRK E CLIP button.



In Phonos literature, controls refer to buttons (and checkboxes) found 
in the Main Screen, the Recording Console, and the MIDI Panel.      
Commands refer to the options that are selected from Phonos' several 
menus.



CD is an arbitrary name given to Phonos' highest sampling rate, 44.1 
kHz, because most audio connoisseurs claim that Compact Disk fidelity
is better than cassette recording, which is the next highest rate.      It 
uses two-to four times as much hard disk space as the other sampling 
rates, but yields smoother contours in the resulting recording and its 
waveform.    Sampling rates are selected in your Recording Console.



Although there is not a Copy command    in    Phonos, it is something 
that takes place quite often , such as when (1) a ClipArea is copied 
from a marked area in a WaveFile and named, then saved, in a ClipFile;
(2) a copy of a ClipArea or WaveFile is retrieved from their respective 
directories for mixing, modification, etc.    These do not exhaust the 
possibilities; in general, copying is something that is part of several 
processes in Phonos and therefore falls within their ken: saving, 
mixing, adjusting, opening, etc.



Cutting out a portion of a WaveFile is like cutting out a portion of a 
word-processed document or a piece of pipe and then rejoining the 
ends.    Use the Delete Marked Area command for this purpose.    If you 
want to save the area being cut out to "paste" or "move" it elsewhere, 
then name and save it as a ClipArea before deleting it from the original
WaveFile.



Clearing is the erasure of a mark    (but not the segment of the 
WaveFile that it marked) when you decide not to make the marked 
area into a ClipArea.    Consequently, it is a simple process, not unlike 
erasing an unsatisfactory pencil mark in a memo or sketch.



If, after recording a WaveFile in your Recording Console, you decide to 
save it as such, then exit the Console with this button.    You will be 
returned to the Main Screen, where the new WaveFile will be written in 
the Waveform Data Views.



If, after recording a WaveFile in the Recording Console, you decide not 
to keep it for any reason, then exit the Console with this button.    You 
will be returned to a blank Main Screen, where you can attempt to re-
record by starting over.



Digital recording, as opposed to analog recording, is the storage of 
information (in this case, audio information) by forming complex 
sequences or matrices of "bits" of information that have an identity of 
either 0 or 1.    The 0 and the 1 can also be thought of as the "digital 
alphabet" that Phonos uses to process whole books in the form of 
WaveFiles.    This differs from analog recording, in which a medium 
stores information by being somehow physically modified (e.g., 
etching, in the case of phonograph records).



Disk space refers to the capacity of your PC's permanent memory 
stored in the "hard disk" which exists within your "hard drive" (an 
actual part of your machine; see glossary entry).    It is here that 
everything you save, be it with an explicit Save command or an 
automatic execution (e.g., the volume adjustment of a ClipArea), is 
kept.    Hard drive disk space (permanent memory) is contrasted with 
system memory (RAM), which is temporary and holds such things as 
unnamed marked areas and unsaved WaveFiles.    Disk space is more 
rapidly consumed by stereo than    mono, and by higher sampling rates.
WaveFiles and ClipAreas use a lot of it, both for sound storage and 
writing waveforms.    MIDI files consume very little disk space.    IQSoft 
recommends a minimum of 120-megabyte capacity.



Data, in a Phonos context, are the tens-of-thousands of bits that 
Phonos assembles and "writes" as waveforms to the two "Data 
Waveform Views" on your Main Screen as it also writes them, with the 
two-digit alphabet (0,1) as recorded sound into your computer's 
memory for retrieval.



Desktop Audio Production is a revolution in usership and technology, in
which ordinary people can enter the fields of audio editing and mixing 
without learning special skills, spending huge sums of money, or 
leaving home.    Phonos was designed to include ever greater numbers 
of people in the revolution.



Editing is that set of skills that once required specialized training and 
expensive, bulky equipment to master.    Desktop Audio Production has 
changed all that.    In Phonos, editing specifically includes recording and
previewing sound files (WaveFiles and ClipAreas), plus cutting, copying,
inserting, deleting, and adjusting their volume.    Editing, as a catchall 
term, occasionally includes the mixing functions (zero- and custom-
point mixing, echo, etc.).



To exit the program or any part of it is to quit it completely.    These 
parts include this glossary, and the help file that contains it.    The 
Phonos-specific Exit command in the File Menu is the user's route out 
of the entire program.    If you have unsaved changes to the current 
WaveFile (if you have not already closed it with the Close Current 
WaveFile command), or if there is a new but unsaved ClipArea, Phonos 
will ask you if you want these saved before you exit the program.



This term has at least two definitions.    Often, it refers to 
discontinuities in audio recordings or editing processes; at other times, 
it may be the audible scarring that results from the manual splicing of 
reel tape or the clicks left by the use of a stop function during 
recording.    The latter type of glitch is an impossibility in Phonos.    As 
to the former, the only discontinuities that will be present in Phonos 
files are those that you want in, for whatever reason.    However, when 
you have recorded an unusually long WaveFile and have commanded 
Phonos to save it, a minute or two may pass while the program writes 
it to the WaveForm Views because a great deal of bits are involved.    
Fortunately, Phonos is able to actually tell you what is taking place.



There are two icons associated with Phonos.    The program icon is 
composed of a compact disk representing the ability of computers to 
digitally read recorded sound, and a WaveFile motif representing the 
myriad editing and mixing capabilities of Desktop Audio Production.    
The IQSoft company logotype sports the initials for Intelligence 
Quotient, to commemorate the intellectual revolution that has finally 
made Desktop Audio Production a possibility for millions of users; the 
initials are on a scroll motif reminiscent of a computer printout.



kHz is the abbreviated form of kiloHertz.    In broadcasting contexts, 
kHz refers to the "Hertzian" (radio and television) frequencies within 
the radio spectrum; in recording industry contexts, it is a series of 
standard cycling rates at which recordings are made; in Phonos, it is a 
corresponding series of sampling rates that the user can choose from 
when recording.



Sound mixing is a process by which part or all of one recording is 
blended with another for a desired combination of sounds.    A vocal, for
instance, can be added to an instrumental, or vice-versa.    A library of 
sound effects can be developed and drawn upon and (for the Phonos 
user) mixed into a WaveFile, which is the original recording.    Mixing is 
done with the commands in your Mix Menu.



The jukebox is a universally familiar entertainment device developed in
the early 20th century.    Early versions from companies such as 
Germany's Wurlitzer, were limited to 10 or 12 vinyl disks as their 
storage medium.    Later boxes could efficiently handle dozens of two-
sided disks.    With Phonos, the jukebox is no longer a coin gobbling 
contraption you have to drive to a bar to play, but a home-
entertainment device, like your VCR.    The actual menu is none other 
than the DOS window, "Open MIDI File," that is reached with your MIDI 
Menu.    Further, the Phonos jukebox has a capacity not of one or 
several dozen songs (or other recordings), but several dozen hundred.



The process of undoing in Phonos is very similar to that of any word 
processing Undo command.    Any unsaved edit, be it a mix, echo, etc. 
can be reverted back to the previous version by "undoing" the last 
operation, or "edit".
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